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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2005 - 2009 Hewlett-Packard Development Company, L.P.

This product includes Xerces XML Java Parser software, which is Copyright (c) 1999 The Apache Software 
Foundation. All rights reserved. 

This product includes JDOM XML Java Parser software, which is Copyright (C) 2000-2003 Jason Hunter & 
Brett McLaughlin. All rights reserved.

This product includes JClass software, which is (c) Copyright 1997, KL GROUP INC. ALL RIGHTS 
RESERVED.

This product includes J2TablePrinter software, which is © Copyright 2001, Wildcrest Associates (http://
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This product includes Xalan  XSLT Processor software, which is  Copyright (c) 1999 The Apache Software 
Foundation.  All rights reserved.

This product includes EXPAT XML C Processor software, which is Copyright (c) 1998, 1999, 2000 Thai Open 
Source Software Center Ltd and Clark Cooper Copyright (c) 2001, 2002 Expat maintainers.
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All rights reserved.
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This product includes HTTPClient Package software, which is Copyright (C) 1991, 1999 Free Software 
Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA  02111-1307 USA.

This product includes Perl software, which is Copyright 1989-2002, Larry Wall. All rights reserved.

This product includes Skin Look And Feel software, which is Copyright (c) 2000-2002 L2FProd.com. All rights 
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Reserved.
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<daniel@haxx.se>. All rights reserved.

This product includes Quartz - Enterprise Job Scheduler software, which is Copyright 2004-2005 
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This product includes Free DCE software, which is (c) Copyright 1994 OPEN SOFTWARE FOUNDATION, 
INC., (c) Copyright 1994 HEWLETT-PACKARD COMPANY, (c) Copyright 1994 DIGITAL EQUIPMENT 
CORPORATION, Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, 
Boston, MA  02111-1307  USA

This product includes DCE Threads software, which is Copyright (C) 1995, 1996 Michael T. Peterson

This product includes Jboss software, which is Copyright 2006 Red Hat, Inc.  All rights reserved.

Trademark Notices

Java™ is a U.S. trademark of Sun Microsystems, Inc.

UNIX® is a registered trademark of The Open Group.

Oracle® is a registered trademark of Oracle Corporation and/or its affiliates.

Windows® is U.S. registered trademarks of Microsoft Corporation. 
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Documentation Updates

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.

The following table indicates changes made to this document since October 2007.  

Chapter Changes

Chapter 1 (a) Added note that says the latest upgrade “patch” package is available via download 
only, it is not available on CD.
(b) Fixes to text about the impact of OVPA polling frequency on tablespace metrics.
(c) Updates to package version history at end of chapter.

Chapter 2 Version number updates.

Chapter 3 Version number updates.

Chapter 4 Minor edits.
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Support

You can visit the HP software support web site at:

http://support.openview.hp.com/support.jsp 

HP Software online support provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels and HP Passport, go to:

http://support.openview.hp.com/new_access_levels.jsp 
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1 Overview
This chapter covers the following topics:

• Introducing HP Performance Insight

• Data Collection for the Database Report Pack 

• The Database Reports

• Thresholds and Integration with OVO

• Thresholds and Integration with OVO

• Options for Customizing Reports

• Sources for Additional Information

• Package Version History

Introducing HP Performance Insight

Performance Insight collects data from many sources, performs in-depth trend analysis, 
maintains performance baselines, and provides users with convenient, web-based reporting. 
Following is a partial list of product features:

• Distributed architecture

• Easy to scale (supports data collection from thousands of agents)

• Supports CODA/OVPA agents

• Multi-company security model

• Data warehousing

• Near Real Time reporting

• Forecasting 

• Extensive aggregation options (by hour, day, week, month; by location, by customer)

• Thresholding and alerting

• Easy identification of bottlenecks

• Easy assessment of capacity trends

• Accurate and timely documentation for management

• Integration with NNM

• Integration with OVO/Operations Manager
9



Many reporting solutions have been created for Performance Insight and new solutions are 
added every year. The newest solutions, released October 2007, are Business Process Insight 
and SiteScope Integration. For a complete list of reporting solutions organized by technology, 
see Appendix A, PI Report Packs.

Data Collection for the Database Report Pack

The only datapipe used by the Database Report Pack is the Database Oracle SPI Datapipe. 
The Database Oracle SPI Datapipe collects data from the Embedded Performance Agent, a 
sub-agent that ships with OVOW 7.2+ and OVOU 7.2+. The Database Oracle SPI Datapipe 
does not collect data from earlier versions of OVOW or OVOU.

The Database Oracle SPI Datapipe polls the EPC data store once every 45 minutes. Because 
changing the polling frequency could interfere with the polling conducted by OVPI for the 
System Resource Report Pack, we recommend that you do not change the polling frequency.

The following table provides a list of metrics polled by the Database Oracle SPI Datapipe. 

Future releases of the Database Report Pack will provide datapipes designed for:

• Sybase

• Informix

• MS SQL Server

• MS Access

Metric Description metricid objectid valueid value

E201_InstUptime Availability 201 Instance name 1 Up = 5
Down = 0

E212_InstSize Instance size 212 Instance name 1 Megabytes allocated

E212_InstSize Instance size 212 Instance name 2 Megabytes free

E210_TblSpcSize Tablespace size 210 Table space name 1 Megabytes allocated

E210_TblSpcSize Tablespace size 210 Table space name 2 Megabytes free

E215_SegmntSize Segment size 215 Segment name 1 Megabytes allocated

E213_TblSpcIO Tablespace I/O 213 Table space name 1 Physical 
reads+writes since 
last collection

E037_USERLOGONCNT User logons NA NA NA Number of user 
logons

NAE044_COMMITRATE Transactions NA NA NA Number of 
transactions
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The Database Reports

The reports in the Database Report Pack perform a ranking function, allowing you to compare 
database instances, spot various kinds of problems before they become serious, and anticipate 
capacity issues. Reports provide easy access to the following information:

• Dynamic space usage over the previous week

• Daily fluctuations in instance-size-free vs. instance-size-used

• Logon activity for the last few hours, per instance

• Availability for the last few hours, per instance

• Number of transactions for the last few hours, per instance

• Details about each customer (uptime, downtime, instance size, logons)

• Details about each location (uptime, downtime, instance size, logons) 

• Segment analysis (Oracle only)

• Tablespace analysis (Oracle only)

The Database SPI Report Pack offers the following features:

• Report linking

• Launch Point page

• Ad hoc selector reports

• Color-coded graphics in selection tables

Report linking means that navigating reports is more like navigating a website. You have 
numerous links to follow and investigating a specific area of interest is easier and more 
efficient. Use the links to move quickly between reports — there is no need to close the report 
you are viewing and then navigate folders. In addition to moving from one report to another 
report within the same report pack, you can link to reports in a different report pack. For 
example, there are links in Database reports that will open reports in the Device Resource 
Report Pack.

The Launch Point page groups reports into categories, providing a convenient overview of the 
package. The Database Report Pack includes two Launch Point pages, one for generic reports 
and one for Oracle reports. The generic Launch Point page offers the following choices:
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The Oracle Launch Point page offers two choices:

The ad hoc selector option opens a report that lets you select specific devices and interfaces 
from a set of drop-down menus. Use the drop-down menus to pinpoint an item of interest. You 
will notice that the report displays quickly. Response time is good due to the limited number of 
database queries.

Categories and Reports

The following table provides a list of the reports in each category.

Category Reports

Generic History Instance Size Details
Instance Size History 

Generic NRT Instance Availability NRT
Instance Transactions NRT
Instance Logons NRT

Customer and Location Customer Summary 
Location Summary

Adhoc Selector and QuickView Instance QuickView
Ad hoc Instance Selector

Oracle Segment Segment Size Details
Segment Size History

Oracle Tablespace Tablespace Size Used Top 20
Tablespace Size Allocated Top 20
Tablespace Size Percentage Used Top 20
Tablespace Size History
Tablespace Physical I/O Top 20
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Reports and Statistics

The following table outlines the statistics available in each report. For information about how 
each statistic is calculated, see Appendix B, Formulas.

Report Statistics

Instance Size Details Instance size allocated
Average instance size used
Average instance size free 

Instance Size History Instance size allocated
Instance dynamic size usage
Average instance size free

Instance Availability NRT Total instance uptime
Total instance downtime
Total instance unknowntime

Instance Transactions NRT Number of transaction
Maximum transactions
Minimum transactions
Average transactions

Instance Logons NRT Total logons
Maximum logons
Minimum logons
Average logons

Customer Details Total uptime
Total downtime
Total instance size free
Total instance logons
Average instance size percent used

Location Details Total uptime
Total downtime
Total instance size free
Total instance logons
Average instance size percent used

Instance QuickView Instance availability NRT details
Instance size usage trend
Average logon trend
Average transaction trend

Adhoc Instance Selector Average instance uptime
Average instance logons
Average instance transactions
Average instance percentage size used
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Segment Size Details Total segment size allocated (MBs)

Segment Size History Average size allocated
Dynamic size allocation
Segment size allocation details

Tablespace Size: Used Top 20 Average megabytes allocated
Average megabytes used

Tablespace Size: Allocated Top 
20

Average megabytes allocated

Average megabytes used

Average megabytes free

Tablespace Size: Percentage 
Used Top 20

Total space allocated

Percent used

Tablespace usage trend

Oracle Tablespace Size: History Average size allocated
Dynamic size usage
Average size free

Oracle Tablespace: Physical I/O 
Top 20

Total physical I/O
Maximum physical I/O
Minimum physical I/O
Average physical I/O

OVPA polls the following Tablespace metrics once a day:

• TblSpaceSizeAllocated

• TblSpaceSizeUsed 

• TblSpaceSizeFree

• TblSpaceSizePercentUsed

• TblSpaceSizePercentFree

• TblSpacePhysicalIO

If the default polling interval is not changed, the values in daily report for total, average, 
maximum, and minimum will not be meaningful. To get meaningful data for total, average, 
maximum, and minimum, the OVPA polling frequency must be modified. For help with that 
step, refer to OVPA documentation.

Report Statistics
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Thresholds and Integration with OVO

You can improve your ability to isolate faults and diagnose problems by installing the optional 
thresholds sub-package that comes with the Database Report Pack and configuring OVO as 
the destination for breach and clear traps generated by OVPI. If you install the optional 
thresholds sub-package, the Thresholds Module will monitor the OVPI database for breach 
conditions and respond to breaches by taking one of several possible actions, for example, 
sending breach and clear traps to OVO.

The thresholds sub-package provides the following defaults:

Instance Availability = 85%

Instance Size Used = 95%

To modify the defaults, open the Instance Customer Location and Threshold Configuration 
form. Enter new threshold values and save your changes. 
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Because Network Node Manager (NNM) is the default destination for traps, you must 
configure the Thresholds Module to send traps to OVO. Do this by opening the SNMP Trap 
Action Definition form. Fill in the necessary information and save your changes. In addition to 
using the SNMP Trap Action Definition form to configure a new destination for traps, your 
OVO administrator must prepare a trap template definition for OVO. The Thresholds Module 
User Guide contains the information needed to prepare the template.

Options for Customizing Reports

The contents of a report can be customized by editing parameters, by editing tables and 
graphs, and by modifying default thresholds. Since there are no customer-oriented reports or 
location-oriented reports in the Database Report Pack, you cannot use group filters to create 
customer-specific reports. For details about editing tables and graphs, see Appendix C, 
Editing Tables and Graphs.

Editing a parameter applies a constraint to the contents of the report, thereby eliminating the 
data you are not interested in seeing. The Database Reporting Report Pack supports the 
following parameters: 

• Instance

• System

• Vendor

• Customer

• Location

If you are using Report Viewer, follow these steps to edit a parameter:

1 Select Edit > Parameter Values from the menu bar.

2 When the Modify Parameter Values window appears, click the Current Value field.

3 Enter a new value.

4 Click OK.

If you are viewing the report on the Web, follow these steps:

1 Click the Edit icon at the bottom right-hand corner of the report.

2 When the Edit Parameters window opens, type the constraint in the appropriate field.

3 Click Submit.

Sources for Additional Information

For information about the latest enhancements to this package, and any known issues, refer 
to the Database Report Pack Release Notes. 

Manuals for the core product, Performance Insight, and manuals for the reporting solutions 
that run on Performance Insight can be downloaded from here:

http://ovweb.external.hp.com/lpe/doc_serv/
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The user guides for PI are listed under Performance Insight. The user guides for report packs 
and datapipes are listed under Performance Insight Report Packs. Every entry indicates a 
publication date. If a manual is revised and reposted, the date will change. Since we post 
revised manuals on a regular basis, you should check this site for updates.

Package Version History

The following table provides a list of enhancements since Version 1.0.

Version Release Date Enhancements

1.0 May 2006 16 reports; Database Oracle SPI Datapipe 1.0

1.1 April 2007 Location Independent Reporting (LIR)
Database Oracle SPI Datapipe 1.1
UPGRADE_Database_to_11
UPGRADE_Database_Oracle_to_11
defect fixes: 
• QXCR1000351048
• QXCR1000351071
• QXCR1000367499
• QXCR1000368580
• QXCR1000386279
• QXCR1000386567

1.1 October 2007 Database Oracle SPI Datapipe 1.2
defect fixes:
• QXCR1000427865 - Map procedure failed, cannot 

insert NULL into DSI_DPIPE.SRDBINST_SEGMENT
• QXCM1000415912 - Oracle Database Report Pack not 

showing all the reports

1.2 February 2008 Copy Policy Enhancement
UPGRADE_Database_to_12.ap
UPGRADE_Database_Oracle_to_12.ap

1.21 September 2009 Database_Upgrade_to_121.ap

The upgrade packages dated February 2008 are not available on CD-ROM. Both must be 
downloaded. The next chapter of this guide contains several references to a report pack CD 
containing installable packages. Since there is no CD, you may ignore those references. If you 
need help downloading or installing the two upgrade packages released February 2008, refer 
to release notes.
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2 The Upgrade Install
This chapter covers the following topics: 

• Guidelines for a Smooth Upgrade

• Upgrading to Version 1.21

• Package Removal

If you are installing the Database Report Pack for the first time, this chapter does not apply to 
you. See Chapter 3, The New Install.

Guidelines for a Smooth Upgrade

When you insert the report pack CD in the CD-ROM drive and launch the package extraction 
program, the install script extracts every package from the CD and copies the results to the 
Packages directory on your system. When the extract finishes, the install script prompts you 
to launch Performance Insight and start Package Manager. Before running Package Manager, 
review the following guidelines:

• Prerequisites for the Database Report Pack

• Datapipes and Remote Pollers

• Custom Table Views

• Upgrading Common Property Tables

• Upgrading Database in a Distributed Environment

Prerequisites for the Database Report Pack

Make sure the following software is installed before upgrading to Database 1.21:

• Performance Insight 5.41

• All service packs available for Performance Insight 5.41

• Common Property Tables 3.91

Datapipes and Remote Pollers

If you uninstall an existing datapipe, the following information is lost:

• Single polling policy for a remote poller

• Cloned polling policies for multiple remote pollers

• Customized polling groups 
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To prevent this information from being lost, you can use the following commands to export 
existing polling policy configurations and customized polling groups:

• collection_manager

• group_manager 

Exporting Polling Policy Configurations

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export existing policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst

Windows: As Administrator, launch a command window. Navigate to the OVPI install 
directory and execute the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, execute the following command: 

cd $DPIPE_HOME

./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the OVPI install 
directory and execute the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups

Custom Table Views

If you are using table views you created yourself, the views you created may interfere with the 
report pack upgrade, causing the upgrade to fail. Whether or not your views interfere with the 
upgrade process depends on how you created them. If you used SQL to create them, the 
upgrade will succeed, however, your custom views will not be available once the upgrade is 
complete. If you used Datapipe Manager to create them, the upgrade is likely to fail. To 
prevent the upgrade from failing, delete custom table views before you upgrade the report 
pack, then recreate those views after the report pack is upgraded.

Upgrading Common Property Tables

If you are running an older version of Common Property Tables, you must upgrade that 
package to version 3.91. If you are not running any version of Common Property Tables, 
Package Manager will install the latest version of Common Property Tables for you, 
automatically.

Do not install an upgrade for Common Property Tables and other packages at the same time. 
Install the upgrade package for Common Property Tables and only the upgrade package for 
Common Property Tables. For more information about installing and using Common Property 
Tables, refer to the Common Property Tables User Guide.
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Upgrading Database in a Distributed Environment

Following is an overview of the installation procedure for a distributed environment:

1 Disable trendcopy on the central server.

2 For the central server:

• Upgrade to Common Property Tables 3.91; deploy reports

• Upgrade to Database 1.21 (including any sub-packages); deploy reports

3 For each satellite server:

• Upgrade to Common Property Tables 3.91 or higher

• Upgrade to Database 1.21 (including any sub-packages)

• Remove Database Oracle SPI Datapipe 1.1

• Install Database Oracle SPI Datapipe 1.2

4 Re-enable trendcopy on the central server.

5 Reconfigure your central and satellite servers.

When Database 1.0 was installed, the person who installed that version had to set up 
connections with satellite server databases, configure trendcopy commands, and switch off 
aggregations above the hourly level at each satellite server. If you just upgraded to 
Performance Insight 5.41, server configuration changes that were made when Database 1.0 
was installed must be redone. For details, see Chapter 4, Setting Up a Distributed System.

Upgrading to Version 1.21

Perform the following tasks to upgrade from any earlier version to version 3.1:

• Task 1: Stop OVPI Timer and extract packages from the report pack CD

• Task 2: Upgrade to Common Property Tables 3.91

• Task 3: Install the Upgrade Packages

• Task 4: Remove Database Oracle SPI Datapipe 1.1

• Task 5: Install Database Oracle SPI Datapipe 1.2

• Task 6: Restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the report pack CD

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.
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On UNIX, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu opens 
automatically; on UNIX, mount the CD if the CD does not mount automatically, navigate 
to the top level directory on the CD, and run the ./setup command. 

4 Type 1 in the choice field and press Enter. The install script displays a percentage complete 
bar. When the copy is complete, the install script starts Package Manager. The Package 
Manager welcome window opens.

If you navigate to the Packages directory on your system, you will see the following folders 
under the Database folder:

• Database.ap

• Database_Threshold.ap

• Database_Oracle.ap

• Database_Sr_Integration.ap

• Database_Demo.ap

•    Database_Upgrade_to_121.ap

• UPGRADE_Database_Oracle_to_12.ap

Task 2: Upgrade to Common Property Tables 3.91

Follow these rules:

• Do not install any other package with the Common Property Tables upgrade package; 
install the Common Property Tables upgrade package and only the Common Property 
Tables upgrade package. 

• When prompted to accept or disable the option to Deploy Reports, accept the default. If 
you do not deploy reports, you will not deploy the change forms that come with Common 
Property Tables.

• When the install finishes, click Done to return to the Management Console.

Task 3: Install the Upgrade Packages

1 From the Management Console, select Tools > Package Manager. The Package Manager 
welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. 

4 Click Next. The Report Deployment window opens. Accept the defaults for Deploy Reports, 
Application Server, and Port. Type your user name and password for the OVPI 
Application Server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following packages (depending on which packages you are 
upgrading):

Database_Upgrade_to_121.ap

UPGRADE_Database_Oracle_to_12.ap
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7 Click Next. The Type Discovery window opens. Disable the default.

8 Click Next. The Selection Summary window opens

9 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package install complete message appears. 

10 Click Done. 

Task 4: Remove Database Oracle SPI Datapipe 1.1

The Database Oracle SPI Datapipe cannot be upgraded. You must remove Database Oracle 
SPI Datapipe 1.1. Start Package Manager and follow the on-screen instructions for package 
removal. When Package Manager tells you that removal is complete, click Done to return to 
the Management Console. 

Task 5: Install Database Oracle SPI Datapipe 1.2

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install.

4 Click Next. The Report Deployment window opens; disable the default for Deploy Reports.

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following package:

Database Oracle SPI Datapipe 1.2

7 Click Next. The Type Discovery window opens. 

8 Click Next. The Selection Summary window opens.

9 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, the package installation complete message appears.

10 Click Done.

Task 6: Restart OVPI Timer 

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Do not be surprised if the UPGRADE package you just installed disappears 
from view. Package Manager will display what you just installed as Database 
Report Pack 1.21. This is not an error.

It is possible that you are already running the latest datapipe, version 1.2. If you are, ignore 
this task.
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Package Removal 

Follow these steps to uninstall the Database Reporting Report Pack:

1 Log in to the system. On UNIX systems, log in as trendadm.

2 Stop OVPI Timer and wait for processes to terminate.

3 Start Package Manager. The Package Manager welcome window opens.

4 Click Next. The Package Location window opens.

5 Click the Uninstall radio button.

6 Click Next. The Report Undeployment window opens.

7 If reports were deployed to the OVPI Application Server, accept the defaults for Undeploy 
Reports, Application Server Name, and Port. Otherwise, clear the check box and skip to 
step 9.

8 Type your username and password for the OVPI Application Server.

9 Click Next. The Package Selection window opens.

10 Click the check box next to the following packages:

Database 1.21 

Database Demo

11 Click OK.

12 Click Next. The Selection Summary window opens. 

13 Click Uninstall. The Progress window opens and the removal process begins. When the 
uninstall process is complete, a package removal complete message appears. 

14 Click Done to return to the Management Console.

15 Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services.

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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3 The New Install
This chapter covers the following topics: 

• Guidelines for a Smooth Install

• Installing the Database Report Pack

• Accessing Deployed Reports

• Package Removal

Guidelines for a Smooth Install

An PI reporting solution has two ingredients, a report pack and a datapipe. Some reporting 
solutions include multiple datapipes. When you install the datapipe, you configure OVPI to 
collect a specific type of data at a specific interval. When you install the report pack, you 
configure OVPI to summarize and aggregate performance data in accordance with specific 
processing directives issued by the report pack.

The report pack CD includes the latest report packs, datapipes, and shared packages. When 
you insert the CD in the CD-ROM drive and launch the package extraction program, the 
install script copies every package from the CD to the Packages directory on your system. 
After the extract finishes, the install script prompts you to start Package Manager. Before 
using Package Manager, review the following guidelines. 

Software Prerequisites

Version 1.21 of the Database Reporting Report Pack has the following prerequisites:

• Performance Insight 5.41

• All service packs available for Performance Insight 5.41

• Common Property Tables 3.91

• SysRes OVPA Collection Datapipe 1.11

• OVO Management Server, version 7.2 or later

• Database Oracle Smart Plug-In (SPI):

— Version B.09.01 for Windows

— Version A.09.10 for UNIX

If you are not currently running any version of Common Property Tables, let Package 
Manager install version 3.91 for you. If you are running an earlier version of Common 
Property Tables, upgrade to version 3.91. Upgrading Common Property Tables is easy; 
however, if you need assistance with the upgrade, or if you want to know more about how this 
package operates, refer to the Common Property Tables User Guide.
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Distributed Environments

If you intend to run Database Reporting in a distributed environment, installation is more 
complicated, since you must install the report pack multiple times, once on the central server, 
and once on each satellite server. Typically, you will not install the datapipe on the central 
server, since the central server is not polling. Where you install the thresholds sub-package 
depends on how you want to implement thresholding. 

Here is an overview of package installation in a distributed environment.

1 Make sure that every server is running PI 5.41.

2 Make sure that every server is running all available service packs for PI 5.41. 

3 Disable trendcopy on the central server.

4 Install the following packages on the central server:

• Common Property Tables 3.91

• SysRes OVPA Collection Datapipe 1.11

• Database Report Pack

• Oracle sub-package

• Thresholds sub-package

5 Install the following packages on each satellite server:

• Common Property Tables 3.91

• SysRes OVPA Collection Datapipe 1.11

• Database Report Pack

• Oracle sub-package

• Thresholds sub-package

• Database Oracle SPI Datapipe 1.2

6 Re-enable trendcopy on the central server.

If you do not want local reporting (viewing reports on satellite servers), there is no need to 
deploy reports to the OVPI Application Server when you install packages on satellite servers. 
However, if you want local reporting, be sure to deploy reports (and forms) when you install 
packages on a satellite server.

When you finish installing packages, you have to set up a distributed system. This involves 
setting up connections with satellite server databases, configuring the central server to copy 
data from satellite servers, and switching off higher-level aggregations at the satellite servers. 
These steps are covered in Chapter 4, Setting Up a Distributed System.

Installing the Database Report Pack

Perform the following tasks to install Database Reporting on a stand-alone system: 

• Task 1: Stop OVPI Timer and extract report packs from the report pack CD

• Task 2: If necessary, upgrade to Common Property Tables 3.91

• Task 3: Install the report pack and the Database Oracle SPI Datapipe
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Task 1: Stop OVPI Timer and extract OVPI packages from the CD

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Control Panel > Administrative Tools > Services

UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. Do one of the following:

• Windows: run the setup.bat command if auto run is disabled. If auto run is enabled, 
a Main Menu appears. 

• UNIX: mount the CD manually if the CD does not mount automatically, then run the 
setup command.

4 Type 1 to select OVPI report packs in the choice field and press Enter. The install script 
displays a percentage complete bar. When extraction is complete, the install script starts 
Package Manager. The Package Manager Welcome window opens.

Task 2: Upgrade Common Property Tables 

If you are running an older version of Common Property Tables, upgrade to Common Property 
Tables 3.91. Do not install the upgrade for Common Property Tables and other packages at 
the same time. Install the upgrade package for Common Property Tables and only the 
upgrade package for Common Property Tables. When Package Manager indicates that the 
installation is complete, click Done to exit Package Manager and return to the Management 
Console. 

Task 3: Installing Database Reporting

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory or use the browse feature to select 
a different directory, if necessary. 

4 Click Next. The Report Deployment window opens. Accept the default settings for Deploy 
Reports; also accept the defaults for application server name and port in the same window. 

You 

If you navigate to the Packages directory on your system, you will see 
the following folders under the Database folder:
• Database.ap
• Database_Threshold.ap
• Database_Oracle.ap
• Database_Sr_Integration.ap
• Database_Demo.ap
•   Database_Upgrade_to_12.ap
• UPGRADE_Database_Oracle_to_12.ap
You may ignore the upgrade packages. Installing the demo package is 
optional. You may install the demo package by itself, or you may 
install the demo package along with the report pack.
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5 Enter your username and password for the OVPI Application Server. 

6 Click Next. The Package Selection window opens. 

7 Select the check box next to the following packages:

Common Property Tables 3.91 

SysRes OVPA Collection Datapipe 1.11

Database Report Pack 1.21 

Database Oracle 1.2 sub-package

Database Oracle SPI Datapipe 1.2

Database Report Pack Demo

8 Click Next. The Type Discovery window opens. 

9 To run Type Discovery immediately after package installation, keep the default and click 
Next. The Selection Summary window opens.

10 Click Install. The Installation Progress window opens and the install process begins. When 
the install process is complete, an installation complete message appears. 

11 Click Done. 

12 Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services.

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Accessing Deployed Reports

When you installed the report pack, you enabled the Deploy Reports option. As a result, the 
reports in this package (as well as the thresholds form) were deployed to the OVPI 
Application Server. Once the reports reside on the OVPI Application Server, you have two 
ways to view them:

• OVPI client applications

• Web browser

If you have the client applications, you have access to Report Viewer, Report Builder, and the 
Management Console. If you do not have the client applications, using a web browser to view 
reports is the only way you can view reports. For more information about the clients, refer to 
the OVPI Installation Guide. For details about the Management Console, including how to use 
the Object/Property Management view to launch reports specific to a selected object, refer to 
the OVPI Administration Guide.
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Package Removal 

Follow these steps to uninstall the Database Reporting Report Pack:

1 Log in to the system. On UNIX systems, log in as trendadm.

2 Stop OVPI Timer and wait for processes to terminate.

3 Start Package Manager. The Package Manager welcome window opens.

4 Click Next. The Package Location window opens.

5 Click the Uninstall radio button.

6 Click Next. The Report Undeployment window opens.

7 If reports were deployed to the OVPI Application Server, accept the defaults for Undeploy 
Reports, Application Server Name, and Port. Otherwise, clear the check box and skip to 
step 9.

8 Type your username and password for the OVPI Application Server.

9 Click Next. The Package Selection window opens.

10 Click the check box next to the following packages:

Database 1.21 

Database Demo 

11 Click OK.

12 Click Next. The Selection Summary window opens. 

13 Click Uninstall. The Progress window opens and the removal process begins. When the 
uninstall process is complete, a package removal complete message appears. 

14 Click Done to return to the Management Console.

15 Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services.

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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4 Setting Up a Distributed System
Follow these steps when setting up a distributed system:

1 Decide whether you want local reporting or central reporting.

2 Install the right set of packages on each server (a central server that is not polling will not 
need datapipes; every satellite servers will need datapipes).

3 Verify that the system clocks in your environment are synchronized.

4 Register your satellite servers.

5 If you are not copying rate data to the central server, enable LIR on the central server.

6 If you enable LIR, add LIR mapping with the time type set to rate.

7 Verify that you have all the copy policies you need.

8 Configure the central server (manual edits to trendtimer.sched and .pro files).

9 Configure each satellite server (manual edits to trendtimer.sched and .pro files).

If you want local reporting, you need to deploy reports when you install the report pack on 
each satellite server, and you also need to allow summarizations to run on each satellite 
server. If you do not want local reporting, then you do not need to deploy reports when you 
install a report pack on a satellite server, and you can disable the scripts that run 
summarizations on each satellite server.

Before Location Independent Reporting (LIR) was available, our recommendation to anyone 
setting up a distributed system was to deploy reports on satellite servers, keep rate data on 
satellite servers, copy hourly data to the central server, and disable summarizations above the 
hourly level on satellite servers. This approach had two benefits. It kept a lot of rate data off 
the network, and it decreased the processing load on the central server. The problem with this 
approach is that the central server could not display a Near Real Time (NRT) report. The only 
NRT report was a local NRT report, on a satellite server. 

LIR fixes this problem. If you enable LIR, you can open an NRT report on the central server 
and drill-down on table selections. The selections you make cause the central server to query a 
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the 
central server, you can. If you do, then enabling LIR is not necessary.

The Database Report Pack comes with a copy policy import file. When you install the report 
pact, PI uses this file to generate copy policies. Creating these policies yourself, using the 
Management Console, is no longer necessary. Your only task is to verify that you have the 
copy policies you need. 

Because you are likely to have multiple satellite servers, we designed the hourly process files 
to be satellite-server friendly. This means that most of the time, most of the defaults are 
correct. But some defaults will be incorrect, or less than optimal, and to improve performance, 
you should change them. These manual edits, as well as the other steps listed above, are 
spelled out in detail in this chapter.
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Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Register the satellite server by setting the database role

• Task 2: If you are not copying rate data from satellites to the central server, enable LIR

• Task 3: If you enable LIR, add LIR mappings

• Task 4: Verify the automatically generated copy policies

• Task 5: Delete LIR mappings for rate tables

• Task 6: Modify the trendtimer.sched file

• Task 7: Modify the Database_Hourly.pro file

Task 1: Register the satellite server by setting the database role

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the database system.

4 Click Database Properties.

5 From the Database Role list, select the Satellite Server role.

6 Enter any information necessary to configure the Satellite Server role.

Task 2: Enable LIR

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Select the LIR enabled check box.

Task 3: Add LIR mappings

Configure LIR mappings for the following categories (for the database and Oracle 
sub-package you have installed): Database and Database_Oracle.

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Click Add Mapping.

6 From the Select Satellite Server list, select a satellite server to which to add a mapping.

7 Select the Category data table option.

8 Select Database from the drop down list.

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application.
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9 Select the rate data type.

10 Click Add to List.

11 If you want to add additional LIR mappings, click Add Mapping and repeat step 6 through 
step 10.

12 Click OK.

13 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 9 above) determines 
the type of data copied that is defined in the generated copy policy (the type of data copied 
that is defined in the generated copy policy is for one greater than the data type selected in 
the LIR mapping). For example, if you select an hourly data type, a daily data copy policy is 
generated.

Task 4: Verify that copy policies were generated automatically

Verify that a copy policy has been generated for the following tables and that the copy type is 
set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 Find the following tables (for the database and sub-package you have installed) and verify 
the copy type is set to Property and Data for each table:  

If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy 
Manager. The Copy Policy Wizard displays.

2 Click Next. The Satellite Server and Copy Policy Selection Page displays.

3 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server.

4 Select Single Table and select the table from the pull down list.

5 Click Next. The Copy Type Selection Page displays.

6 Select Property and Data.

7 Click Next. The Summary page displays.

8 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back.

9 Click Finish.

10 Repeat step 4 - step 9 for all missing tables.

If the copy type is not set to Property and Data, do the following:

1 Double-click the copy policy.

2 Select the Property and Data copy type.

Database Oracle Sub-package

SHDBINSTANCE SHDBINST_SEGMENTS

SRDBINSTANCE SHDBINST_TBLSPACES
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3 Click OK.

Task 5: Delete LIR Mappings for the SRDBINSTANCE rate table

Delete the LIR mappings for SRDBINSTANCE (the data is being copied to the central server).

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Unselect the Rate check box for K_DBINSTANCE and KV_DBINSTANCE.

6 Click Apply.

Task 6: Modify the trendtimer.sched file

The trendtimer.sched file is found in the {DPIPE_HOME}/lib/ directory where 
{DPIPE_HOME} is the directory in which OVPI is installed.

If you installed the Oracle sub-package, make the following change to this file:

• Find and comment out the following line:

1:00+30 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/Database_Oracle_Hourly.pro

Task 7: Modify the Database_Hourly.pro file

The Database_Hourly.pro file is found in the {DPIPE_HOME}/scripts/ directory where 
{DPIPE_HOME} is the directory in which OVPI is installed.

Make the following change to this file:

• Comment out the DB_1 block section.

• Comment out the DB_2 block section.

Configuring a Satellite Server

Follow these steps to configure a satellite server.

1 Disable aggregations at the daily level and above.

a Open the {DPIPE_HOME}/lib/trendtimer.sched file (where {DPIPE_HOME} is 
the directory in which OVPI is installed)

b Find and comment out the following lines:

24:00+3:00 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/Database_DMF.pro

24:00+3:00 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/Database_Oracle_DMF.pro

2 Modify the {DPIPE_HOME}/scripts/Database_Hourly.pro file (where 
{DPIPE_HOME} is the directory in which OVPI is installed):
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• Comment out the DB_3 block, including the begin and end lines.

3 If you installed the Oracle sub-package, modify the {DPIPE_HOME}/scripts/
Database_Oracle_Hourly.pro file:

• Uncomment the DB_1 block, including the begin and end lines.

System Clocks

Verify that the system clock on each satellite server is synchronized with the system clock on 
the central server.
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5 Generic History Reports
There are two generic history reports in Database Reporting:

1 Instance Size History 

2 Instance Size Details Top 20

Instance Size History

This report looks at dynamic space usage over the previous week, and allows you to spot 
instances with the highest dynamic space usage. The building block in this report is a daily 
average for instance-size-used and a daily average for instance-size-free. The daily averages 
are rolled up, producing averages for the week that appear in the top selection table.

The top selection table sorts instances by dynamic space usage, most to least. The data in the 
usage details table below the selection table shows the daily fluctuation in average 
instance-size-free vs. average instance-size-used. The tabbed graph below the usage details 
table displays a daily bar chart and a monthly bar chart. Both charts show the fluctuation in 
free vs. used, allowing you to see historic trends. 

Instance Size Details Top 20

This report reveals which database instances are using the most instance size. It measures 
instance size three ways:

• As a percentage

• In megabytes

• In megabytes allocated

Each selection table on the left looks at yesterday’s data. Each graph to the right shows what 
the trend has been over the previous 7 days.
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6 Generic NRT Reports
There are three generic NRT reports in the Database Report Pack:

1 Instance Availability in Near Real Time

2 Number of Transactions in Near Real Time

3 Number of logons in Near Real Time

Availability NRT

Contains one selection table and one tabbed graph. The selection table looks at actual sample 
data collected over the previous six hours, not hourly averages. The selection table shows:

• Total Instance Uptime in minutes

• Total Instance Downtime in minutes

• Total Instance Unknowntime in minutes

The selection table sorts instances by Total Instance Uptime, most to least. Use the graph 
below the selection table to see trending on an hourly, daily, and monthly basis.

Logons NRT

Contains one selection table and one tabbed graph. The selection table looks at actual sample 
data collected over the previous six hours, not hourly averages. The selection table shows:

• Total logons

• Maximum logons (per hour)

• Minimum logons (per hour)

• Average logons (per hour)

The selection table sorts instances by Total Instance Uptime, most to least. Use the tabbed 
graph below the selection table to see trending on an hourly, daily, and monthly basis.

Transactions NRT

Contains one selection table and one tabbed graph. The selection table looks at actual sample 
data collected over the previous six hours, not hourly averages. The selection table shows:

• Total transactions

• Maximum transactions (per hour)

• Minimum transactions (per hour)

• Average transactions (per hour)

The selection table sorts instances by Total Instance Uptime, most to least. Use the tabbed 
graph below the selection table to see trending on an hourly, daily, and monthly basis.
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7 Aggregation Reports
There are two aggregations reports in the Database Report Pack:

• Customer Summary Report

• Location Summary Report

See below for samples of each.
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8 Selector & QuickView
See below for samples of:

• Adhoc Instance Selector

• Instance QuickView
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9 Oracle Segment Reports
There are two segment reports in the Database Report Pack:

• Segment Size History

• Segment Size Details

See below for samples of each.
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10 Oracle Tablespace Reports
There are five tablespace reports in the Database Report Pack:

• Tablespace Physical I/O Top 20

• Tablespace Size History

• Tablespace Size Allocated Top 20

• Tablespace Size Used Top 20

• Tablespace Size Percentage Used Top 20
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A PI Report Packs
Business Technology Reporting Solution

Application Application Report Pack:
• WebLogic SPI
• WebSphere SPI

Database Database SPI Report Pack

HP Business Process Insight BPI Report Pack

HP Internet Services Internet Services Report Pack

HP Network Node Manager NNM Event & Availability Report Pack

HP Operations Manager OVO Report Pack

HP SiteScope SiteScope Integration Report Pack

IP Telephony • Cisco IP Telephony Call Detail
• Cisco IP Telephony Gateway Statistics

MPLS VPN MPLS VPN Report Pack

Networking Infrastructure Usage

• Interface Reporting
• Device Resource Report Pack

LAN/WAN Edge

• Frame Relay (SNMP only) 
• ATM (SNMP only)

WAN Core

• Frame Relay (multiple switch vendors)
• ATM (multiple switch vendors)

Traffic Profiling

• RMON II

• NetFlow Interface

• NetFlow Global View

• IP QoS Report Pack
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Networking (continued) • Class-Based QoS

Quality Assurance

• Cisco Ping Report Pack
• Service Assurance
• IP Access Rate

System Resources System Resource Report Pack
• CPU
• Disk
• Logical System
• Logical Volume
• NetIf
• Process

Business Technology Reporting Solution
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B Formulas
Main Package Formulas

If a metric cannot be collected directly from the EPC sub-agent, OVPI calculates it. The 
following table indicates how each metric is calculated. 

Oracle Sub-Package Formulas

The following formulae are used to calculate metrics for reports in the Oracle sub-package.

Metric How the Metric is Calculated

Instance uptime Time in minutes the database instance was up

Instance downtime Time in minutes the database instance was down

Instance unknowntime Time that is unaccounted for, time when the instance was 
neither up nor down = (60 – Uptime – Downtime)

Instance percent uptime Average Percent Up time of database instance = 
(InstUpTime/60) * 100

Instance percent downtime Average Percent Down time of database instance = 
(InstDownTime/60) * 100

Instance percent unknowntime Average Unknown time of database instance = 
((InstUpTime+InstDownTime)/60) * 100

Instance size allocated Total size of memory allocated by this instance, measured 
in megabytes

Instance size free Amount of memory still free from the total allocated, 
measured in megabytes

Instance size used Amount of memory used, measured in megabytes = 
(InstanceSizeAllocated – InstanceSizeFree)

Instance size percent used Average Percent Instance Size Used = (InstSizeUsed/
InstSizeAllocated) * 100

Instance size percent free Average Percent Instance Size Used = (InstSizeFree/
InstSizeAllocated) * 100

Metric How the Metric is Calculated

Tablespace Size Allocated Total size of Tablespace, measured in megabytes
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Tablespace Size Free Amount of free Tablespace size, measured in megabytes

Tablespace Size Used Amount of used Tablespace size, measured in megabytes = 
(TblSpaceSizeAllocated – TblSpaceSizeFree)

Tablespace Size Percent Used Average Percent Tablespace Size Used = (InstSizeUsed/
InstSizeAllocated) * 100

Tablespace Size Percent Free Average Percent Tablespace Size Used = (InstSizeFree/
InstSizeAllocated) * 100

Segment Size Allocated Total size of segment, measured in megabytes

Instance Logons Number of logons for an instance

Instance Transactions Number of transaction for an instance

I/O Number of physical I/O operations for a tablespace

Metric How the Metric is Calculated
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C Editing Tables and Graphs
Any table or graph can be viewed in several ways. Although the default view is usually 
adequate, you can easily change to a different view. If you are using Report Viewer, right-click 
the object to open a list of view options. If you are using the Web Access Server, follow these 
steps to change the default view of a table or graph:

1 Click Preferences on the links bar.

2 Expand Reports in the navigation frame.

3 Click Viewing.

4 Select the Allow element editing box.

5 Click Apply.

6 Click the Edit icon next to the table or graph. 

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options. 

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens.
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Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 

View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 
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The following table provides details about each option.

Style Options

Select Style to display a list of seven view options for graphs.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.

Export Element as CSV... Same as the table option shown above.

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location  

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below. 

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten. 

Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers. 
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Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day. 

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 
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Display Data Table

This option changes a graph into a spreadsheet. 

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window.  
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Product name:

Document title:

Version number:

Feedback:





 



 


	User Guide
	Contents
	1 Overview
	Introducing HP Performance Insight
	Data Collection for the Database Report Pack
	The Database Reports
	Categories and Reports
	Reports and Statistics

	Thresholds and Integration with OVO
	Options for Customizing Reports
	Sources for Additional Information
	Package Version History

	2 The Upgrade Install
	Guidelines for a Smooth Upgrade
	Prerequisites for the Database Report Pack
	Datapipes and Remote Pollers
	Exporting Polling Policy Configurations
	Exporting Polling Group Configurations

	Custom Table Views
	Upgrading Common Property Tables
	Upgrading Database in a Distributed Environment

	Upgrading to Version 1.21
	Package Removal

	3 The New Install
	Guidelines for a Smooth Install
	Software Prerequisites
	Distributed Environments

	Installing the Database Report Pack
	Accessing Deployed Reports
	Package Removal

	4 Setting Up a Distributed System
	Configuring the Central Server
	Configuring a Satellite Server
	System Clocks

	5 Generic History Reports
	Instance Size History
	Instance Size Details Top 20

	6 Generic NRT Reports
	Availability NRT
	Logons NRT
	Transactions NRT

	7 Aggregation Reports
	8 Selector & QuickView
	9 Oracle Segment Reports
	10 Oracle Tablespace Reports
	A PI Report Packs
	B Formulas
	Main Package Formulas
	Oracle Sub-Package Formulas

	C Editing Tables and Graphs
	View Options for Tables
	View Options for Graphs
	Style Options
	Style > Area
	Style > Stacking Area
	Style > Bar
	Style > Stacking Bar
	Style > Plot
	Style > Pie

	Display Data Table
	View in New Frame


	Index

	We appreciate your feedback!
	Comments



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


